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EN 3INTRODUCTION
You can find the latest information (in English) on the provided software program at our world wide web 
server at http://www.jvc-victor.co.jp/english/index-e.html

● Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation in the 
United States and/or other countries.

● Macintosh is a registered trademark of Apple Computer, Inc.
● Other product and company names included in this instruction manual are trademarks and/or registered 

trademarks of their respective holders.

This document consists of the following sections.
Before use, please read “SOFTWARE INSTALLATION AND USB CONNECTION GUIDE” for preparation.

� Digital Photo Navigator (Only Windows®, and for users equipped with D.S.C. (Digital Still 
Camera) features)

This section explains how to load still images into the album of the Digital Photo Navigator and how to 
handle still images using the Digital Photo Navigator software. You can send still images by e-mail and store 
an album as a web page.

CAUTION:
● Operate this equipment according to the operating procedures described in this manual.
● Use only the provided CD-ROM. Never use any other CD-ROM to run this software.
● Do not attempt to modify this software.
● Changes or modifications not approved by JVC could void user’s authority to operate the equipment.

ATTENTION:
When connecting a USB cable or a DV cable to PC
● (Only for D.S.C. equipped models) Never switch the VIDEO/MEMORY (DSC) mode on the camcorder 

when the USB cable is connected. It may cause the camcorder not to be recognized by the PC. If it 
occurs, confirm that the PC is not accessing the camcorder, then disconnect the USB cable and connect 
it again.

● Never turn on or off the camcorder when the USB or DV cable is connected. It may cause malfunctions 
of the PC.

How to handle a CD-ROM
● Take care not to soil or scratch the mirror surface (opposite to the printed surface). Do not write anything 

or put a sticker on either the front or back surface. If the CD-ROM gets dirty, gently wipe it with a soft 
cloth outward from the center hole.

● Do not use conventional disc cleaners or cleaning spray.
● Do not bend the CD-ROM or touch its mirror surface.
● Do not store your CD-ROM in a dusty, hot or humid environment. Keep it away from direct sunlight.

Reading this document
Download from Www.Somanuals.com. All Manuals Search And Download.
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� ImageMixer 1.7
This section introduces the ImageMixer software. In addition to capturing still images and creating albums, 
ImageMixer is used for a variety of other functions, including color and brightness adjustment, and capturing 
videos through a USB cable or a DV cable. ImageMixer is also used to edit your captured video and then 
create a Video CD.* For details, refer to the ImageMixer help.
* To create a Video CD, a CD-R drive is necessary. If you are using a Windows® PC, refer to the following web 

site for a drive that is compatible with Windows®:
http://www.imagemixer.com
If you are using a Macintosh, the application ToastTM by Roxio, Inc. is also necessary.

� Holding a video conference over the Internet (Windows® Only)
This section explains how to use a camcorder as a web camera and to hold a video conference over the 
Internet. (� pg. 36)

� Loading files from a memory card through an adapter (Only for users equipped with D.S.C. 
(Digital Still Camera) features)

This section explains how to load images into the PC that does not have a USB connector. (� pg. 40)

� Troubleshooting

The following symbols are used in this document.

NOTE:
Indicates problems that could occur while using these softwares, phenomena that may appear to be a 
problem, limitations on the use of these softwares, or other information that is useful to know.

�
Indicates pages where related information can be found.

CONTINUED ON NEXT PAGE
Indicates that the explanation continues on the next page.

Under copyright law, any material that you may edit with this software cannot be used for any purpose other 
than your own personal enjoyment without the permission of the copyright holder. Note that this restriction 
applies when dubbing tracks from a CD as background music for your own movies.

Meanings of symbols

Copyrights
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EN 5Digital Photo Navigator

DIGITAL PHOTO NAVIGATOR (Windows® Only)
This section is only for users equipped with D.S.C. (Digital Still Camera) features.
Send your favorite videos and pictures by e-mail
Everyone has video cassettes and memory cards containing videos and pictures that they never get to show to 
anyone.
No matter how wonderful, the only people that got to see them were families and guests, because there was 
no convenient way to show them except in your own home on the TV. Friends and relatives who live far away 
had no way of viewing them. And you don’t want to throw those video cassettes and memory cards away 
because they hold treasured memories.
Now you can solve all of these problems with a PC. By using a USB cable to connect a camcorder to a PC, 
you can copy video clips from the camcorder to the PC. You can then send the files to anyone as an e-mail 
attachment.

Loading Still Images
The Digital Photo Navigator software allows you to store and view still images in a photo album format.

Playing Back and Handling Images
You can send still image files as an e-mail attachment and store an album as a web page.

Create a virtual album
If you have a lot of image files with similar names, it can be hard to remember which file contains which 
image.
You can use this software to display these images on your PC just as if you had pasted them in a photo album. 
Because you can scan through these images just as if you were flipping through a photo album, you can 
quickly find a specific image that you want to send through e-mail, for example.

Capabilities
M4D3+DSC_Soft_04PhotoNavi.fm Page 5
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6 EN ADDING STILL IMAGES TO AN ALBUM
You can use Digital Photo Navigator to create an album that contains a collection of still images.

1 Click [Start], go to [Programs] – [Digital Photo Navigator], and then click [Digital Photo 
Navigator 1.0].

Digital Photo Navigator starts.
● Close any other programs running on the PC.
● Disable any programs that run in the background, such as screen savers, e-mail applications, virus 

checkers, schedulers, etc.
● Turn off file and printer sharing.

2 Click [Import].

3 Click [Image].
The [Open] dialog box appears.

4 Open the folder that contains the desired still images.

● Select the folder of the still images copied to the PC and click [Open].
The still image files appear in the window.

5 Select the desired still image files and click [Open]. The still images are added to the right-
hand side of the Digital Photo Navigator window.
● You may select more than one file.
● You can also add files by dragging and dropping them in the Digital Photo Navigator window.

CONTINUED ON NEXT PAGE
M4D3+DSC_Soft_04PhotoNavi.fm Page 6
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EN 7ADDING STILL IMAGES TO AN ALBUM (cont.)
6 Add additional still images as desired by repeating steps 3 – 5.

NOTES:
● When loading images from a memory card, never disconnect the USB cable while the message 

[ACCESSING FILES] is displayed in the camcorder’s LCD monitor.
● Digital Photo Navigator can only load still images. Digital Photo Navigator cannot load video clips.

7 Click [Export].

8 Click [Album].
The [Save As] dialog box appears.

9 Specify the location where you want to save the album, enter the file name of the album, 
and then click [Save].
The album is saved.
● If you save an album for the first time after the software installation, a message appears and asks if you 

want to register the association of the file extension name “jia”. Then, click [Yes].
● To exit Digital Photo Navigator, refer to “EXITING DIGITAL PHOTO NAVIGATOR” (See below).

EXITING DIGITAL PHOTO NAVIGATOR

1 Click the [File] menu and then click [Exit].
● If you have already saved an album, a confirmation message appears. Then, go to step 2.
● If you have not saved an album after loading still images, a confirmation message appears.
To save an album, click [Yes]. The [Save As] dialog box appears. Specify the location where you want to 
save the album, enter the file name of the album, and then click [Save]. A confirmation message 
appears. Then, go to step 2.
To exit Digital Photo Navigator without saving an album, click [No]. A confirmation message appears. 
Then, go to step 2.

2 Click [Yes].
Digital Photo Navigator closes.
M4D3+DSC_Soft_04PhotoNavi.fm Page 7
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8 EN LOADING AN ALBUM
1 Start Digital Photo Navigator. (� pg. 6)
2 Click [Import].

3 Click [Album].
The [Open] dialog box appears.

4 Open the folder where the album was saved.

5 Click the desired album file, and then click [Open].
The contents of the album are displayed in the right-hand side of the Digital Photo Navigator window.

6 Click [Export].

NOTES:
● You can also open the album file by dragging and dropping it in the Digital Photo Navigator window.
● If an album is currently open, a confirmation message appears.

• If you want to open the newly selected album instead of the one already opened, click [Yes]. If you have 
not saved the album already opened, a confirmation message appears. If you want to save the album, 
click [Yes]. If you do not want to save the album, click [No].

• If you want to add still images from the newly selected album to the album already opened, click [No].
M4D3+DSC_Soft_04PhotoNavi.fm Page 8
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EN 9DISPLAYING STILL IMAGES
Displaying a selected still image
You can select for display any of the still images that are displayed in the right-hand side of the Digital Photo 
Navigator window.

1 Double-click the still image to be displayed.
The [Image Viewer] window appears, and the selected image is displayed.

Displaying a series of images
To display a series of images in “slide show” fashion, click the  button in the [Image Viewer] window. You 
can also move through the images manually in either direction by clicking the  and  buttons.

To adjust the speed of the slide show, right-click the [Image Viewer] window and then, in the menu that 
appears, click [Slide show] – [Setting Interval Time]. Set the length of the interval (in seconds), and then click 
[OK].

NOTE:
The interval for a slide show is a little longer than the setting because of display processing time.

Stop slide show

First image Last image

Next image

Start slide show

Previous image
M4D3+DSC_Soft_04PhotoNavi.fm Page 9
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Enlarging and reducing images
The following procedure describes how to change the display size of a still image.

1 Drag the corner of the [Image Viewer] window to change the size of the window to the 
desired display size.

2 Right-click the [Image Viewer] window and then, in the 
menu that appears, click [Zoom] – [Auto].
The size of the still image is automatically enlarged or reduced 
to fit the window, and the display magnification (enlargement/
reduction percentage) indicated in the title bar of the window 
changes accordingly.

Other enlargement/reduction functions
In addition to adjusting the size of the image to the size of the 
window, the display size of a still image can also be changed by the 
methods described below. Each of these functions can be selected by 
right-clicking the [Image Viewer] window.
● [Zoom] – [Real Size]: Displays the image in its original size 

(display magnification of 100%).
● [Zoom] – [Zoom In]: Displays the image at twice its current display magnification (up to 400%).
● [Zoom] – [Zoom Out]: Displays the image at half its current display magnification (up to 20%).

Display magnification
M4D3+DSC_Soft_04PhotoNavi.fm Page 10
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EN 11ORGANIZING ALBUMS
Whenever necessary, you can delete or copy still images that you have added to an album. The procedure 
described below only affects the still image in the album. It does not affect the original file of the still image 
that was added to the album.

To delete or copy multiple still Images at once, select them in advance. You can also select all still images in 
the album.

Selecting still images continuously
Click still images while holding down the Shift key.

If you click one still image while holding down the Shift key, the images of smaller numbers are selected as 
well.

Selecting still images one by one
Click still images while holding down the Ctrl key.

Selecting all of the still images
Click [Select All] in the [Edit] menu.

Selecting multiple still images

Shift + Click

Click

Ctrl + Click
M4D3+DSC_Soft_04PhotoNavi.fm Page 11
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1 Click the still image that you want to delete, and then click [Delete] in the [Edit] menu.
A confirmation message appears.

2 Click [Yes].
The selected still images are deleted.

1 Click the still image that you want to copy, and then click [Copy] in the [Edit] menu.
2 Click the image that is located right after the insertion point.

● To add the images at the end of the album, click the blank space in the right-hand side of the window.

3 Click [Paste] in the [Edit] menu.
The copied still images are inserted right before the selected image.

NOTE:
You can delete, copy or paste an image also by right-clicking it.

Deleting unnecessary still images

Copying still images

Insertion point
M4D3+DSC_Soft_04PhotoNavi.fm Page 12
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EN 13SENDING IMAGES FROM AN ALBUM IN E-MAIL
Still images in an album can be sent as an e-mail attachment.

Preparation: Before using the [E-Mail] function
If you use the Internet Explorer, be sure to use the version 5.5 or later.
When installing the Internet Explorer, select a typical set of components.

1 Click the still image that you want to send, and then click [E-Mail].

The new message window in your e-mail program appears, and the still image file is registered as an 
attachment.

NOTES:
● Depending on an e-mail software, a new message window may not open when the [E-Mail] button is 

clicked.
● Depending on an e-mail software, settings such as “Set as MAPI client” or “Used by MAPI application” are 

necessary.
● The maximum number of messages that can be created at once is three.
M4D3+DSC_Soft_04PhotoNavi.fm Page 13
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14 EN CREATING A WEB PAGE
You can save the contents of an album in HTML format. This is useful in the following instances:

When creating a web page: You can create a web page that features a collection of photos.
When distributing an album: You can create an album in a format that can be displayed by a web 

browser. This is useful if you want to distribute the album on CD-R, etc.

1 Select the still images that you want to save in HTML format.

● To select more than one still image, hold down the Shift key or the Ctrl key while clicking the images.
● To select all of the still images, click [Select All] in the [Edit] menu.

2 Click [Web Page].
The [Web Page] dialog box appears.

3 Set the following items when necessary.
● [Title]: This will be the title of the web page.
● [Font Color]: This specifies the color of the title text.
● [Back Color]: This specifies the background color of the web page. (Specify a color other than the font 

color.)
● [Limit horizontal size of the images]: This allows you to specify the maximum width of the image 

when displayed by a web browser. (Set the number of pixels much smaller than the width of the PC’s 
display.)

CONTINUED ON NEXT PAGE
M4D3+DSC_Soft_04PhotoNavi.fm Page 14
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4 Click [OK], specify the save location, and then click [Save].
The HTML file is saved, and a folder with the same name is saved at the same time. A confirmation 
message appears next, asking whether to display the web page.

5 Click [Yes].
The web browser opens, and the HTML file that was created is displayed.

● Click on an image on the web page to enlarge it.

What Next?
You can also view an HTML file through the web browser by double-clicking the HTML file. You can upload 
the HTML file to your home page, or save it on a CD-R or some other media and distribute it.
Always handle HTML files and folders as a set. Without its folder, an HTML file cannot be viewed by a web 
browser.

NOTES:
● For more details on how to create a home page, consult your Internet service provider’s web site or one of 

the many reference books available.
● Use third-party home page creation software or similar software to edit HTML files.
M4D3+DSC_Soft_04PhotoNavi.fm Page 15
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16 EN CHANGING THE IMAGE SIZE OR PICTURE QUALITY
This procedure describes how to change the size of an image that has been loaded into Digital Photo 
Navigator. This procedure is used to reduce the size of an image that is being attached to an e-mail or saved 
in an album.

1 Select the still image to be changed.

● To select more than one still image, hold down the Shift key or the Ctrl key while clicking the images.
● To select all of the still images, click [Select All] in the [Edit] menu.

2 Click [Change Format].
The [Image Format] dialog box appears.

3 Select one of the following items:

● [Expansion/Reduction]: Set any desired image size in the [Width] and [Height] fields. If the [Keep 
aspect ratio] check box is not selected (off), both [Width] and [Height] fields can be changed.

● [Generic Size]: Select the size from a list of generic sizes.
● [PDA Size]: This is an image size (160 x 160) that can be displayed on most PDAs.

4 Click [OK].
● If you select more than one still image in step 1, a confirmation message appears.
•If you want to apply the same format to all images, click [Yes].
•If you do not want to apply the same format, click [No]. The first image is saved. Then, select the image 

size for each image.
The image size is changed to the selected size. If the vertical-to-horizontal ratio was changed, the blank 
spaces are shown as black.

Changing the image size
M4D3+DSC_Soft_04PhotoNavi.fm Page 16
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In addition to changing the size of an image, it is also possible to rotate images, change or correct the quality 
of an image, and change the file format of an image. The role of each setting is described in more detail 
below.

[90 degrees Rotation]
If you hold the camcorder sideways when recording an 
image, you can create an image that is taller than it is 
wide. Because this still image will be displayed sideways, 
use this function to rotate the image 90 degrees to the 
portrait orientation.
[None]: No correction
[Clockwise]: Rotates the image 90 degrees clockwise.
[Counterclockwise]: Rotates the image 90 degrees 
counterclockwise.

[Image Correction (DV)]
This setting is not available.

[Format]
You can select the file format of an image.
[JPEG]: This is the format that is typically used on the Internet. This format has a smaller file size.
[BITMAP]: This is the standard Windows® image format (BMP). Many applications can use this format.

[JPEG Quality]
This setting is available when JPEG was selected in the [Format] field. Moving the slider to the left makes the 
file smaller. Moving the slider to the right results in less deterioration in the image quality. The initial setting is 
75.

NOTES:
● When [JPEG] is selected in the [Format] field, the quality of the image deteriorates slightly each time that 

[OK] is clicked for the [Image Format] dialog box. To restore the original image quality, reload the original 
still image file.

● To confirm the file size, right-click the still image and then select [Properties].

Changing the picture quality, etc.
M4D3+DSC_Soft_04PhotoNavi.fm Page 17
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18 EN RETRIEVING STILL IMAGES FROM AN ALBUM
You can retrieve still images from an album and save them as a file.

1 Select the still image to be retrieved.

● To select more than one still image, hold down the Shift key or the Ctrl key while clicking the images.
● To select all of the still images, click [Select All] in the [Edit] menu.

2 Click [Image].
The [Image Format] dialog box appears.

3 Change the image format as desired. (� pg. 16) Then, click [OK].

● At this point, you can change the image size and picture quality as desired. (� pg. 16)
The [Save As] dialog box appears.

4 Specify the location where you want to save the file, enter the file name, and then click 
[Save].
The image file is saved.
● If you select more than one still image in step 1, a confirmation message appears.
•If you want to save all images with the same image format and their default name, click [Yes]. The 

[Auto Save Result] dialog box appears. Then, click [OK].
•If you want to set the image format and enter file name for each image, click [No]. The first image is 

saved. The [Image Format] dialog box appears for the second image. Repeat steps 3 and 4 as many 
times as necessary.
M4D3+DSC_Soft_04PhotoNavi.fm Page 18
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EN 19CREATING A LIST OF STILL IMAGES
You can arrange multiple still images together and save them in a single still image file.

1 Holding down the Shift key or the Ctrl key, select the still images that are to be added to the 
list.

2 Click [Multi Image].
The [Multi Image] dialog box appears.

3 Select the number of partitions.

● Either 4, 9, or 16 partitions may be selected.

4 Click [Back Color], select the color for the overall background, and then click [OK].

5 Change the positions of the still images as desired.

● Deleting an image: Right-click the still image and then select [Delete].
● Adding an image: Drag an image from the right-hand side of the Digital Photo Navigator window to 

the [Multi Image] dialog box.
M4D3+DSC_Soft_04PhotoNavi.fm Page 19
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6 Click [Save].
The [Image Format] dialog box appears.

7 Change the image format as desired. (� pg. 16) Then, click [OK].

● At this point, you can change the image size and picture quality as desired. (� pg. 16)
The [Save As] dialog box appears.

8 Specify the location where you want to save the file, enter the file name, and then click 
[Save].
The still image list file is saved.
M4D3+DSC_Soft_04PhotoNavi.fm Page 20
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EN 21CREATING A SLIDE SHOW OR AN ANIMATION
You can create a slide show or an animation in which a series of still images are displayed, and then save 
those images as a movie file (extension “.avi”).
[Slide Show]: Still images are displayed for several seconds each, one at a time.
[Animation]: Several still images are displayed per second. We recommend that you select a series of still 
images that create the appearance of continuous movement. This mode is also suitable for playing back still 
images that was recorded with Interval Shooting function (Only for D.S.C. equipped models).

1 Holding down the Shift key or the Ctrl key, select several still images.

2 Click [Movie].
The [Movie Settings] dialog box appears.

3 Select either [Slide Show] or [Animation], which ever is desired.

● For a slide show, set the length of the interval (in seconds).
● For an animation, set the number of displayed frames (images) per second.

4 Set the following items when necessary.
● [Image Size]: Select the size of the movie file.
● [Compressor]: Select the type of compressor.
● [Back Color]: This item is used if the aspect ratio of the images is not 4:3.

5 Click [OK].
The [Save As] dialog box appears.

6 Specify the location where you want to save the file, enter the file name, and then click 
[Save].
● The file name can be changed.
The movie file is saved, and a confirmation message that asks if you want to play the movie now appears.

7 Click [Yes].
The movie file is played back.

NOTES:
● If you change the [Compressor] item, make sure that the playback system supports that type of compressor.
● Depending on the selected type for [Compressor], a movie file cannot be created.
● In some cases, the settings in the [Video Compression] dialog box are invalid.
M4D3+DSC_Soft_04PhotoNavi.fm Page 21
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ImageMixer 1.7

IMAGEMIXER 1.7
The ImageMixer software possesses a variety of functions. Its primary applications are described below.

Editing your own original movies
ImageMixer allows you to capture video from a camcorder, rearrange scenes, add special effects when 
changing scenes, insert still images, and otherwise freely edit your own movies. ImageMixer also allows you 
to add audio and background music.
The edited movie is stored in MPEG1 format, which provides a comparatively smaller file size. This makes it 
more convenient to distribute it to your friends, for example, expanding the range of possibilities for which 
you can use your camcorder.

Capturing video from tape*
Connect the camcorder to the PC with a USB cable. ImageMixer can then convert the video on tape to 
MPEG1 format and store it in the PC.

Capturing video in real time*
Connect the camcorder to the PC with a USB cable. ImageMixer can then record on the hard disk in the PC, 
instead of on the tape.

Loading still images from a memory card (Only for D.S.C. (Digital Still Camera) equipped models)
Connect the camcorder to the PC with a USB cable. ImageMixer can then load still images from a memory 
card.

Capturing audio from a microphone or CD
ImageMixer can record audio from the PC’s microphone. Because the recording can be made while playing 
the video back at the same time, it is easy to add audio that is in sync with previously recorded video. 
ImageMixer can also add music from a CD as background music for your movie.

*These features are not available when ...
… the camcorder and a Windows® 98 PC are connected with a USB cable
… the camcorder and a Windows® 98/98SE PC or Macintosh are connected with a DV cable

Editing still images
ImageMixer can adjust the brightness and contrast of still images and extract only the necessary portions. 
ImageMixer also has a variety of functions for correcting eye color tones that are too red.
In addition, ImageMixer allows you to freely lay out still images, pictures, text, and other elements to create 
your own postcards, CD-R labels, etc.

Managing files on hard disk
ImageMixer can manage elements that can be used in movie editing (video, still images, audio) as albums. 
Aside from permitting checking of files in list format or through a slide show, ImageMixer can also perform 
file operations such as search, move, duplicate, and delete. In addition to making movie editing easier, these 
functions are also useful for classifying and managing images with a camcorder.

Capabilities

CONTINUED ON NEXT PAGE

Download from Www.Somanuals.com. All Manuals Search And Download.



IMAGEMIXER 1.7 (cont.) EN 23

Master Page: Right

M4D3+DSC_Soft.book  Page 23  Tuesday, December 16, 2003  2:08 PM
Create a Video CD
After you load and edit video clips on your PC, you are ready to create a Video CD* (� pg. 32). It is also 
possible to create a Video CD from camcorder’s tape directly (Windows® only). Since up to 64 minutes of 
video can be recorded to a 650 MB CD, you can easily use a Video CD to send files too large for e-mail 
attachment.
Video CDs can also be played back on most DVD players, so they are useful when you want to send video to 
someone who does not own a PC.
* To create a Video CD, a CD-R drive is necessary. If you are using a Windows® PC, refer to the following web 

site for a drive that is compatible with Windows®:
http://www.imagemixer.com
If you are using a Macintosh, the application ToastTM by Roxio, Inc. is also necessary.

Add a camera to your PC
You can transform your camcorder into a peripheral for your PC.
For example, when you are shooting a video, you can record on your PC instead of on a cassette. You can 
also use Windows® NetMeeting®, Windows® Messenger (Windows® XP only) (or similar software) in 
combination with this software to hold a video conference over the Internet. (In order to conduct a video 
conference over the Internet with Windows® NetMeeting® or Windows® Messenger, you must register with 
MSN Messenger and Microsoft HotMail.)

This manual only provides an overview of ImageMixer. For more details, refer to the help.
To display the help, click the [?] button located in the upper right corner of the ImageMixer screen. Clicking 
this button launches the web browser and displays the help.

For more details on how to use ImageMixer, refer to the following User Support Center.
North America (Los Angeles)
Telephone: +1-213-341-0163
Europe (U.K.)
Telephone: +44-1489-564-764
Asia (Philippines)
Telephone: +63-2-438-0090

IMPORTANT:
Differences from Digital Photo Navigator
Unlike Digital Photo Navigator, ImageMixer only registers the location of an image file and its thumbnail 
image in albums. When images are handled by ImageMixer, the original file is affected by the operation. 
For example, if an image is deleted from an album, the original file is deleted. If a file is moved, 
ImageMixer loses track of where the file resides. Therefore, file operations should be conducted carefully.

Help

PIXELA User Support Center
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24 EN CAPTURING VIDEO
When a camcorder is connected to the PC with a USB cable, the video from the camcorder can be recorded 
on the PC’s hard drive instead of on tape or in a memory card (Only for D.S.C. equipped models) — real-time 
capture.

NOTE:
There are differences in the following procedures whether your camcorder is equipped with D.S.C. (Digital 
Still Camera) features or not.

1 Make sure that no cassette is in the camcorder. (Only for D.S.C. non-equipped models)

2 Connect the camcorder to the PC with a USB cable.
● Refer to “Connections (Windows®)” or “Connections (Macintosh)” in “SOFTWARE INSTALLATION 

AND USB CONNECTION GUIDE”.

3 Set the camcorder’s VIDEO/MEMORY Switch to “MEMORY”. (Only for D.S.C. equipped 
models)

4 Set the camcorder’s Power Switch to “A” or “M” while pressing down the Lock Button 
located on the switch.
The camcorder is now on.
“ ” appears on the camcorder’s LCD monitor.
● If “ ” does not appear, install [USB Video Streaming driver]. Refer to “Software Installation 

(Windows®)” and “Software Installation (Macintosh)” in “SOFTWARE INSTALLATION AND USB 
CONNECTION GUIDE”.

NOTE:
The procedure is different when reading or writing a memory card. (Only for D.S.C. equipped models)

5 Click [Start], go to [All Programs] or [Programs] – [PIXELA] – [ImageMixer], and then click 
[ImageMixer Ver.1.7].

● For Macintosh, double-click the [ImageMixer] icon on the PC.

ImageMixer starts up.

Capturing video in real time

CONTINUED ON NEXT PAGE

Download from Www.Somanuals.com. All Manuals Search And Download.



CAPTURING VIDEO (cont.) EN 25

Master Page: Right

M4D3+DSC_Soft.book  Page 25  Tuesday, December 16, 2003  2:08 PM
6 Click the Input button.

The input mode screen appears.

7 Click the USB input (USB) button.

The USB input mode screen appears.

8 Click the Video button.
The amount of available storage space is displayed in the information display panel.

9 Click the Capture button.
The capture operation begins.

10 Click the Capture button again.
Once conversion ends, the video file (MPEG1) is registered in the album.

NOTE:
If the MPEG1 files cannot be converted to MPEG4 files with ImageMixer, install Windows MediaTM Player 
(version 7 or later). Windows MediaTM Player can be loaded from Microsoft’s web site: 
http://www.microsoft.com/

Input

USB input (USB)

Capture

Video

Information display panel

CONTINUED ON NEXT PAGE
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Capturing still images

1 Click the Still image button.
2 Click the Capture button.

The video image at the moment that the button was clicked is captured, and the resulting still image file 
is registered in the album.

NOTES:
● It is not possible to capture videos or still images if the USB Video Streaming driver is not installed properly. 

In this case, refer to “Updating [Device Manager] (Windows®)” in “SOFTWARE INSTALLATION AND USB 
CONNECTION GUIDE”.

● On the information display panel or the file information dialog, some information such as file-created date 
may be incorrect.

Disconnecting the USB cable
1 Disconnect the USB cable.
2 Set the camcorder’s Power Switch to “OFF”.

The camcorder turns off.

Capture

Information display panel

Still image
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When a camcorder is connected to the PC with a USB cable, video can be copied from the camcorder tape to 
the PC.

NOTE:
There are differences in the following procedures whether your camcorder is equipped with D.S.C. (Digital 
Still Camera) features or not.

1 Set the camcorder’s VIDEO/MEMORY Switch to “VIDEO”. (Only for D.S.C. equipped 
models)

2 Set the camcorder’s Power Switch to “PLAY” while pressing down the Lock Button located 
on the switch.
The camcorder is now on.

3 Click [Start], go to [All Programs] or [Programs] – [PIXELA] – [ImageMixer], and then click 
[ImageMixer Ver.1.7].

● For Macintosh, double-click the [ImageMixer] icon on the PC.

ImageMixer starts up.

4 Click the Input button.

The input mode screen appears.

Capturing video from tape

Input

CONTINUED ON NEXT PAGE
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5 Click the USB input (USB) button.

The USB input mode screen appears. After a while, a blue screen appears.

Copying video

1 Click the Video button.
The amount of available storage space is displayed in the information display panel.

2 Click the Play button.
The camcorder begins playing back the video, and the same image appears on the PC screen.

3 Click the Capture button.
The capture operation begins.

4 Click the Capture button again.
Once conversion ends, the video file (MPEG1) is registered in the album.

NOTE:
If the MPEG1 files cannot be converted to MPEG4 files with ImageMixer, install Windows MediaTM Player 
(version 7 or later). Windows MediaTM Player can be loaded from Microsoft’s web site: 
http://www.microsoft.com/

USB input (USB)

Capture

Video

Information display panel

Play

CONTINUED ON NEXT PAGE
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EN 29CAPTURING VIDEO (cont.)
Disconnecting the USB cable
1 Disconnect the USB cable.
2 Set the camcorder’s Power Switch to “OFF”.

The camcorder turns off.

NOTES:
● If you are using a Windows® PC, you can use a DV cable instead of a USB cable to capture video. In this 

case, click the Digital video camera input (1394) button in step 5 on page 28. For more details, refer to the 
help. (� pg. 23)

● To copy a video as a still image, click the Still image button in step 1 of “Copying video” and perform 
steps 2 – 4.

● It is not possible to edit video keeping DV format. Use other DV editing application software available.
● If you capture video from a tape via an optional DV cable, noise may appear depending on the type or the 

performance of the hardware. In this case, use the USB cable.

MANAGING FILES

ImageMixer can group and search for files (still images, video, and audio) registered in an album, according 
to their purpose. To play back a file, double-click on its thumbnail.

Menu

Select album Image editing

Change
display Thumbnail

Search

Change display
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30 EN EDITING VIDEO
ImageMixer can edit video files registered in an album. ImageMixer can also insert still images and add 
audio.

Double-clicking on one of the (video or still image) thumbnails arranged at the bottom of the screen causes 
the editing window to appear. The beginning/ending of videos can be deleted and the volume can be 
adjusted. The display time for still images can be adjusted.

Select video editing Material selection

Edit

Thumbnail

Preview

Create video

Arrange
thumbnails

Apply scene 
change effects

Arrange audio
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To check the results of editing, click the Preview button. Once editing is complete, click the Create video 
button to save the final product.

Cropping editing

Sound editing

Cropping

OK
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32 EN CREATING A VIDEO CD
If your computer is equipped with a CD-R drive, you can use ImageMixer to create a Video CD from video 
clips captured on your PC or from camcorder’s tape directly.

NOTES:
● If you are using a Windows® PC, refer to the following web site for a drive that is compatible with 

Windows®:
http://www.imagemixer.com

● If you are using a Macintosh, the CD authoring application ToastTM by Roxio, Inc. and a compatible CD-R 
drive is also necessary to create a Video CD. Follow the steps below to create a Video CD image file, and 
then open it with ToastTM and create the Video CD.

● Some CD-R drives are incompatible. For details, please refer to the ImageMixer help. (� pg. 23)
● It is only possible to play back the created Video CD with the player which conform with Video CD 

standard Version 2.0.
● The image quality may be deteriorated when you create Video CD with video captured from the camcorder 

via a USB cable.

1 On the first screen of ImageMixer or ImageMixer screen, click the Video CD button. 

The Menu/Layout screen appears.

Creating a Video CD from video clips on the PC

Video CD

CONTINUED ON NEXT PAGE
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2 After registering the video clips and entering the title and button name, click the Preview/
Create button.

The Preview/Create screen appears.

3 Insert a blank CD-R disc in the CD-R drive and click the Create button to create a Video 
CD.

Specify background
and music

Specify the menu
screen style

Style settings
Button settings

Title settings

Preview/Create
Enter the title

Move the Movie 
button
(registered video 
clips)

Enter the button 
name

Set up

Preview

Create
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Using ImageMixer Video CD Creation you can easily create Video CD from tape in the camcorder connected 
with a USB cable.

NOTE:
There are differences in the following procedures whether your camcorder is equipped with D.S.C. (Digital 
Still Camera) features or not.

1 Connect the camcorder to the PC with a USB cable.
● Refer to “Connections (Windows®)” in “SOFTWARE INSTALLATION AND USB CONNECTION 

GUIDE”.

2 Insert a blank CD-R disc in the CD-R drive.

3 Set the camcorder’s VIDEO/MEMORY Switch to “VIDEO”. (Only for D.S.C. equipped 
models)

4 Set the camcorder’s Power Switch to “PLAY” while pressing down the Lock Button located 
on the switch.
The camcorder is now on.

5 On the ImageMixer screen, click the Video CD Creation startup button.

The Video CD Creation screen appears.

6 Select the drive and the speed for writing to the disc.
● Be sure to set the writing speed to the setting recommended by the drive manufacturer.

Creating a Video CD from tape (Windows® Only)

Video CD Creation startup

Click to select the drive.

Click to select the writing speed.

Option

Start

CONTINUED ON NEXT PAGE
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7 Click [Option].
Specify a work folder in which downloaded video files will be saved.
● If there is not enough free disc space, operations may not work properly. Select a hard drive with as 

much free space as possible.

8 Click [Start].
The process of downloading video from the camcorder’s tape starts automatically.

9 Click [Stop].

The writing process starts.

When the writing process ends, a confirmation screen appears.

10 Click [Quit] to exit Video CD Creation.

NOTE:
You can use a DV cable instead of a USB cable to create Video CD by clicking the Digital video camera input 
(1394) button before performing step 5 on page 34. However, the capturing pauses every 20 minutes during 
the writing process with a DV cable. These pauses create few-second blank portions in the created Video CD.

Stop
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Appendix

VIDEO CONFERENCE OVER THE INTERNET
You can use Windows® NetMeeting® to conduct video conferences over the Internet, using a camcorder.

NOTE:
There are differences in the following procedures whether your camcorder is equipped with D.S.C. (Digital 
Still Camera) features or not.

Preparation
1 Confirm that Windows® NetMeeting® 3.0 or later and MSN Messenger Service are installed.

● You can download the latest version of Windows® NetMeeting® or MSN Messenger Service from 
Microsoft’s web site:

http://www.microsoft.com/

2 Install [USB Video Streaming driver].
● Refer to “Software Installation (Windows®)” in “SOFTWARE INSTALLATION AND USB 

CONNECTION GUIDE”.
● If the installation of [USB Video Streaming driver] has already been completed, go to step 3 or 4.

3 Make sure that no cassette is in the camcorder. (Only for D.S.C. non-equipped models)

4 Connect the camcorder to the PC with a USB cable.
● Refer to “Connections (Windows®)” in “SOFTWARE INSTALLATION AND USB CONNECTION 

GUIDE”.

5 Set the camcorder’s VIDEO/MEMORY Switch to “MEMORY”. (Only for D.S.C. equipped 
models)

6 Set the camcorder’s Power Switch to “A” or “M” while pressing down the Lock Button 
located on the switch.
The camcorder is now on.
“ ” appears on the camcorder’s LCD monitor.
● If “ ” does not appear, install [USB Video Streaming driver]. Refer to “Software Installation 

(Windows®)” in “SOFTWARE INSTALLATION AND USB CONNECTION GUIDE”.

NOTE:
The procedure is different when reading or writing a memory card. (Only for D.S.C. equipped models)

7 Click [Start], go to [Settings] – [Control Panel], and then double click the [Multimedia] icon. 

8 Select the [Audio] tab and click [JVC PIX-MCV Audio Capture] or [JVC PIX-MC10 Audio 
Capture] in the [Preferred device] box.

9 Start NetMeeting®, and set up the program as instructed on the screen.
● An environment that provides for connection to the Internet and an e-mail address are also required.
● Select [JVC PIX-MCV Audio Capture] or [JVC PIX-MC10 Audio Capture] as a recording device in the 

[Audio adjustment] wizard.

10 In the [Conference] menu, click [Directory].
The [Find Other Party] dialog box appears.

11 Register with HotMail as instructed on the screen.

12 Set up MSN Messenger as instructed on the screen.
● If setup was completed previously, the MSN Messenger Service logon window appears.

13 Exit NetMeeting® and MSN Messenger Service.

Using Windows® NetMeeting® (Windows® Only)

CONTINUED ON NEXT PAGE

Download from Www.Somanuals.com. All Manuals Search And Download.



VIDEO CONFERENCE OVER THE INTERNET (cont.) EN 37

Master Page: Right

M4D3+DSC_Soft.book  Page 37  Tuesday, December 16, 2003  2:08 PM
Videoconferencing
1 Connect to the internet.
2 Make sure that no cassette is in the camcorder. (Only for D.S.C. non-equipped models)

3 Connect the camcorder to the PC with a USB cable.
● Refer to “Connections (Windows®)” in “SOFTWARE INSTALLATION AND USB CONNECTION 

GUIDE”.

4 Set the camcorder’s VIDEO/MEMORY Switch to “MEMORY”. (Only for D.S.C. equipped 
models)

5 Set the camcorder’s Power Switch to “A” or “M” while pressing down the Lock Button 
located on the switch.
The camcorder is now on.
“ ” appears on the camcorder’s LCD monitor.
● If “ ” does not appear, install [USB Video Streaming driver]. Refer to “Software Installation 

(Windows®)” in “SOFTWARE INSTALLATION AND USB CONNECTION GUIDE”.

NOTE:
The procedure is different when reading or writing a memory card. (Only for D.S.C. equipped models)

6 Start NetMeeting®, and click [Directory] in the [Conference] menu.
The MSN Messenger Service logon window appears.

7 Log on to the MSN Messenger Service as instructed on the screen.

8 In the list of [Current Friends Online], specify the party with whom you will 
videoconference.
You can now begin the videoconference if your friends respond. The same environment is necessary for 
your friends.

NOTE:
Never turn the Power switch of a camcorder during video conference.

For details, refer to the help for the MSN Messenger Service and NetMeeting®. Details on how to use 
NetMeeting® are expected to be available on the JVC web site.

JVC web site:
http://www.jvc-victor.co.jp/english/index-e.html

NOTES:
● If you are using Windows® 98, you cannot use the microphone in the camcorder. Either connect a third-

party microphone to the PC, or use the PC’s own microphone.
● If you are using a dial-up router or a broadband router, refer to the router’s instruction manual.
● If you are using a firewall or a router, it is not possible to connect to the internet properly.
● Consult your Internet service provider for details before using NetMeeting®.
● Depending on the condition of the line, the quality of images or sound during videoconferences may differ.
● You can also send the video of a tape which the camcorder is playing back. In this case, set the camcorder’s 

VIDEO/MEMORY Switch to “VIDEO” in step 4 (Only for D.S.C. equipped models) and the Power Switch to 
“PLAY” in step 5.
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CONTINUED ON NEXT PAGE

If you are using a Windows® XP, you can use Windows® Messenger to conduct video conferences over the 
Internet, using a camcorder.

NOTE:
There are differences in the following procedures whether your camcorder is equipped with D.S.C. (Digital 
Still Camera) features or not.

Preparation
1 Confirm that Windows® Messenger 4.6 or later is installed.

● You can download the latest version of Windows® Messenger from Microsoft’s web site:
http://www.microsoft.com/

2 Connect to the Internet and set up Windows® Messenger.
● Start Windows® Messenger and register your e-mail address and other information. For details, refer to 

the Windows® Messenger help.

3 Install [USB Video Streaming driver].
● Refer to “Software Installation (Windows®)” in “SOFTWARE INSTALLATION AND USB 

CONNECTION GUIDE”.
● If the installation of [USB Video Streaming driver] has already been completed, go to step 4 or 5.

4 Make sure that no cassette is in the camcorder. (Only for D.S.C. non-equipped models)

5 Connect the camcorder to the PC with a USB cable.
● Refer to “Connections (Windows®)” in “SOFTWARE INSTALLATION AND USB CONNECTION 

GUIDE”.

6 Set the camcorder’s VIDEO/MEMORY Switch to “MEMORY”. (Only for D.S.C. equipped 
models)

7 Set the camcorder’s Power Switch to “A” or “M” while pressing down the Lock Button 
located on the switch.
The camcorder is now on.
“ ” appears on the camcorder’s LCD monitor.
● If “ ” does not appear, install [USB Video Streaming driver]. Refer to “Software Installation 

(Windows®)” in “SOFTWARE INSTALLATION AND USB CONNECTION GUIDE”.

NOTE:
The procedure is different when reading or writing a memory card. (Only for D.S.C. equipped models)

8 In the main screen of Windows® Messenger, click [Tools] and then select [Audio and Video 
Tuning Wizard…].

9 Select [JVC PIX-MCV Video Capture] or [JVC PIX-MC10 Video Capture] and then click 
[Next].
● Make sure that the image from the camcorder is displayed.

10 Click [Next]. In the microphone setting, specify [JVC PIX-MCV Audio Capture] or [JVC PIX-
MC10 Audio Capture]. In the speaker setting, specify the sound board that you are using.
● If you specify [JVC PIX-MCV Audio Capture] or [JVC PIX-MC10 Audio Capture] for the microphone 

setting, you cannot select [Use headphones].

11 Click [Next]. Check the speaker or headphone volume.
● Click [Test] and check for sound from your speakers or headphones.

12 Click [Next]. Check the microphone volume.
● The microphone volume is automatically adjusted. Speak into the camcorder microphone and check 

the microphone volume level so that the green bar extends into the yellow range.

13 Click [Next] and exit the Wizard.

Using Windows® Messenger (Windows® XP Only)
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Videoconferencing
1 Connect to the internet.
2 Make sure that no cassette is in the camcorder. (Only for D.S.C. non-equipped models)

3 Connect the camcorder to the PC with a USB cable.
● Refer to “Connections (Windows®)” in “SOFTWARE INSTALLATION AND USB CONNECTION 

GUIDE”.

4 Set the camcorder’s VIDEO/MEMORY Switch to “MEMORY”. (Only for D.S.C. equipped 
models)

5 Set the camcorder’s Power Switch to “A” or “M” while pressing down the Lock Button 
located on the switch.
The camcorder is now on.
“ ” appears on the camcorder’s LCD monitor.
● If “ ” does not appear, install [USB Video Streaming driver]. Refer to “Software Installation 

(Windows®)” in “SOFTWARE INSTALLATION AND USB CONNECTION GUIDE”.

NOTE:
The procedure is different when reading or writing a memory card. (Only for D.S.C. equipped models)

6 Log on to the Windows® Messenger.
● Register your friend’s e-mail address beforehand. For details, refer to the Windows® Messenger help.

7 In the Windows® Messenger screen, make sure that someone is online besides yourself.
● Another friend must be online for you to call.

8 Right-click the name of your friend.

9 Click [Start Video Chat].
The videoconference screen appears while you wait for a response from your friend. You can now begin 
the videoconference if your friend clicks [Agree].

NOTE:
Never turn the Power switch of a camcorder during video conference.

If the Image does not appear
● Upgrade to Windows® Messenger 4.6 or later. You can download the latest version of Windows® Messenger 

from Microsoft’s web site:
http://www.microsoft.com/

● Update your version of Windows® XP. Click [Start], and select [Windows Update] in [All Programs]. For 
details, refer to the Windows® XP help or the Microsoft web site:
http://www.microsoft.com/

For details, refer to the help for the Windows® Messenger. Details on how to use Windows® Messenger are 
expected to be available on the JVC web site.

JVC web site:
http://www.jvc-victor.co.jp/english/index-e.html

NOTES:
● When you use Windows® Messenger, your friend must use the same application. If your friend uses 

Windows® NetMeeting®, please use Windows® NetMeeting® version 3.0 or later. (� pg. 36)
● If you are using a dial-up router or a broadband router, refer to the router’s instruction manual.
● If you are using a firewall or a router, it is not possible to connect to the internet properly.
● Consult your Internet service provider for details before using Windows® Messenger.
● Depending on the condition of the line, the quality of images or sound during videoconferences may differ.
● You can also send the video of a tape which the camcorder is playing back. In this case, set the camcorder’s 

VIDEO/MEMORY Switch to “VIDEO” in step 4 (Only for D.S.C. equipped models) and the Power Switch to 
“PLAY” in step 5.
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40 EN LOADING FILES FROM A MEMORY CARD THROUGH AN ADAPTER
This section is only for users equipped with D.S.C. (Digital Still Camera) features.
You can read and write files on a camcorder memory card by using an adapter (sold separately).

The following description assumes that a floppy disk adapter is being used. For details on how to use each 
specific type of adapter, refer to the instructions provided with that adapter.

1 Remove the memory card from the camcorder.
2 Insert the memory card in the floppy disk adapter.

3 Insert the floppy disk adapter into the floppy disk drive of the PC.

4 Copy the necessary files from the floppy disk to the hard disk.

Floppy disk adapter
(CU-VFSD50)

: For PCs that do not have a USB connector, or which are running Windows® 95/
NT

PC card adapter
(CU-VPSD60)

: For PCs with a PC card slot

USB reader/writer
(CU-VUSD70)

: For applications that use numerous memory cards
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EN 41TROUBLESHOOTING
Windows®

SYMPTOM CORRECTIVE ACTION

Although the USB cable is 
connected, PC operating system 
does not recognize the memory card 
in the camcorder or the camcorder.

•Make sure that the AC Adapter is connected to the camcorder and 
that the power is on.

•Make sure that the USB cable is connected securely. (� 
“SOFTWARE INSTALLATION AND USB CONNECTION GUIDE”)

•Either use a USB hub that has its own power supply, or connect the 
USB cable directly to the PC’s USB connector.

•Windows® might not be recognizing the USB connector. Make sure 
that the USB (Universal Serial Bus) controller within [Device 
Manager] is usable.

Cannot copy or save files. •Make sure that there is enough free space available in the drive 
where you are trying to copy or save a file.

•Make sure that the drive where you are trying to copy or save a file is 
not write-protected.

•Make sure that a file with the same name does not already exist 
where you are trying to copy or save a file.

•Either use a USB hub that has its own power supply, or connect the 
USB cable directly to the PC’s USB connector.

Cannot load still images into Digital 
Photo Navigator.

•Sometimes the format of the still image data prevents it from being 
loaded into Digital Photo Navigator. Use other graphics drawing or 
processing software to convert the file to either bitmap format or 
JPEG format.

•Make sure that there is enough free space available in the drive in 
which Digital Photo Navigator is installed.

Still images have a mosaic 
appearance.

•When a small image is loaded and enlarged, it will take on a mosaic 
appearance. (� pg. 10)

• If an image is saved with a lower JPEG quality or if the format of the 
image is changed, it will take on a mosaic appearance. (� pg. 17)

The colors displayed on the PC are 
odd.

• Images will not be displayed correctly if the display is set for 256-
color (or fewer) display.

No audio or video during 
ImageMixer operations.

•Verify and change Windows® and ImageMixer settings. If this does 
not work, update your hardware drivers for Windows® XP. You can 
download the latest version of the drivers from your PC’s 
manufacturer’s web site.

[Found New Hardware Wizard] 
screen appears. (Windows® XP)

•Disconnect the cable, then connect the cable used when installing 
the driver.

The created date of the file is not 
displayed correctly on the 
information display panel.

•The created date is not displayed correctly if the date is not set on 
the camcorder.

NOTE:
When using a laptop PC, operation may be interrupted by a warning when the battery is nearly exhausted.
● If there is software which monitors the status of the battery running in the [StartUp] folder…

Close the application, or delete/move its icon from the [StartUp] folder and reboot your PC.
● If you are using your PC’s power management function…

Right-click the [My Computer] icon, then select [Properties]–[System Properties]–[Device Manager]–
[System Devices]–[Advanced Power Management Support]. Deactivate the power management function.
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Macintosh

SYMPTOM CORRECTIVE ACTION

Although the USB cable is 
connected, PC operating system 
does not recognize the memory card 
in the camcorder or the camcorder.

•Make sure that the AC Adapter is connected to the camcorder and 
that the power is on.

•Make sure that the USB cable is connected securely. (� 
“SOFTWARE INSTALLATION AND USB CONNECTION GUIDE”)

•Either use a USB hub that has its own power supply, or connect the 
USB cable directly to the PC’s USB connector.

Cannot copy or save files. •Make sure that there is enough free space available in the drive 
where you are trying to copy or save a file.

•Make sure that the drive where you are trying to copy or save a file is 
not write-protected.

•Make sure that a file with the same name does not already exist 
where you are trying to copy or save a file.

•Either use a USB hub that has its own power supply, or connect the 
USB cable directly to the PC’s USB connector.

The created date of the file is not 
displayed correctly on the 
information display panel.

•The created date is not displayed correctly if the date is not set on 
the camcorder.
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